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1 What's New

New features in ODBC Driver for Dynamics 365
Business Central 1.0

Initial release of ODBC Driver for Dynamics 365 Business Central 1.0

Windows 32-bit is supported

Windows 64-bit is supported

2 General Information

1. Overview

2. Features

3. Compatibility

4. Requirements

5. Licensing

6. Getting Support

2.1 Overview

Overview
Devart ODBC Driver for Dynamics 365 Business Central is a high-performance connectivity

solution with enterprise-level features for accessing Dynamics 365 Business Central

Customer Engagement (formerly known as Dynamics CRM) from ODBC-compliant

reporting, analytics, BI, and ETL tools on Windows, macOS, and Linux. Our ODBC driver fully

supports standard ODBC API functions and data types and enables easy and secure access

to live Dynamics 365 Business Central data from anywhere.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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Connection to Dynamics 365 Business Central

Our data connector enables various ODBC-aware applications to connect to Dynamics 365

Business Central directly via HTTPS. If you have no direct access to Dynamics 365 Business

Central via HTTPS, you have the option of establishing a connection through a proxy server.

2.2 Features

Connection to Dynamics

365 Business Central

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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Our connectivity solution enables various

ODBC-aware applications to connect to

Dynamics 365 Business Central directly via

HTTPS. If you have no direct access to

Dynamics 365 Business Central, you have

the option of establishing a connection

through a proxy server.

Extended SQL Syntax

Our ODBC driver provides an unrivalled

opportunity to work with Dynamics 365

Business Central objects just as with SQL

tables. The extended SQL syntax allows

you to use all the SQL benefits in SQL-92

compatible SELECT statements:

Complex JOINs

WHERE conditions

Subqueries

GROUP statements

Aggregation functions

ORDER statements

and more.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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DML Operations

Devart ODBC Driver for Dynamics 365

Business Central provides support for DML

(INSERT, UPDATE, DELETE) operations,

which allows you to modify data in

Dynamics 365 Business Central in the

same way as in SQL databases.

Bulk Updates

Moreover, with our driver you can perform

bulk updates to Dynamics 365 Business

Central by combining SQL statements into

batches, thus simplifying and speeding up

large data modification with Dynamics 365

Business Central.

ODBC Conformance

The driver provides full support for common

ODBC interface:

ODBC API Functions support

ODBC Data Types support

In addition, we provide support for

Advanced Connection String parameters.

Thus allowing any desktop and web

applications to connect to Dynamics 365

Business Central from various

environments and platforms, that support

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
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ODBC.

Dynamics 365 Business

Central Compatibility

Our ODBC driver fully supports all data

types defined in the Dynamics 365

Business Central API.

Moreover, the driver is compatible with the

Dynamics 365 Business Central API itself.

Advanced Data Conversion

We have implemented advanced Data

Conversion mechanisms that provide bi-

directional mapping between any

Dynamics 365 Business Central and

ODBC data types.

Integration

The driver is compatible with 3rd-party data

analysis tools, such as Microsoft Excel, and

integrates with various IDEs and systems

like Visual Studio, etc.

For a complete list of compatible tools and

platforms, see Compatibility.

Platforms Variety

Devart ODBC Driver for Dynamics 365

Business Central can be used with 32-bit

and 64-bit applications on both x32 and

x64 platforms, so there is no need to

Fully Unicode Driver

With our fully Unicode driver, you can

retrieve and work with any data from multi-

lingual Dynamics 365 Business Central

databases correctly, not depending on

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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additionally configure the driver,

applications or environment.

whether its charset is Latin, Cyrillic,

Hebrew, Chinese, etc., in any environment

localization.

High Performance

Every operation with Dynamics 365

Business Central becomes significantly

faster using such capabilities of our driver

as Local data caching, connection pooling,

query optimization and much more.

Support

Visit our Support page to get instant help

from knowledgeable and experienced

professionals, a quick resolution of your

problems, and nightly builds with hotfixes.

2.3 Compatibility

Dynamics 365 Business Central Compatibility

Dynamics 365 Business Central API

Dynamics 365 Business Central Data Types

Supported Platforms
Windows 32-bit and 64-bit (including Windows Terminal Server)

Compatible with all Windows versions (Windows Vista and higher) that support .NET

Framework 4.5.

Compatibility with Third-Party Tools

  Application Development Tools

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
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Adobe ColdFusion

Embarcadero Delphi & C++Builder
  UniDAC, FireDAC, dbGo (ADO), BDE and dbExpress

FileMaker

Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio
  Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

Python

  Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

SQL Server Reporting Services

  BI & Analytics Software

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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Alteryx

DBxtra

Dundas BI

FICO Xpress Mosel

IBM SPSS Statistics

MicroStrategy

Oracle BI

Power BI

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

TIBCO Spotfire

  Office Software Suites

LibreOffice

Microsoft Access

Microsoft Excel

OpenOffice

StarOffice

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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2.4 Requirements

The following requirements must be met for ODBC Driver for Dynamics 365 Business

Central:

Only one version of ODBC Driver for Dynamics 365 Business Central is installed on your

system.

.NET Framework 4.5 or later is installed on your system.

2.5 Licensing

ODBC Driver License Agreement

--------------------------------------------------

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING

THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND

BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE

TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND

PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you

(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver

software application, demos, intermediate files, printed materials, and online or electronic

documentation contained in this installation file. For the purpose of this Agreement, the

software program(s) and supporting documentation will be referred to as the "Software".

LICENSE

1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,

subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the

registration letter you have received from Devart upon purchase of the Software:

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/


ODBC Driver for Dynamics 365 Business Central10

© 2025 Devart Request Support ODBC Forum Provide Feedback

- the "Desktop Edition" allows you to install and use the Software on a single desktop

computer, provided it is accessed by no more than one person at a time, either directly or

remotely, for sole purposes only in accordance with this Agreement. If more than one person

can simultaneously use the computer where you plan to install the product, you must

purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it

is accessed by more than one person at a time, either directly or remotely. This definition

includes, but is not limited to, Web servers, application servers, batch servers, and desktop

workstations, where more than one concurrent users can access the Software. A Server

License is valid for one single server installation, provided it is used by 1 (one) legal entity in

accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the

registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single

computer only during the subscription term specified at purchase. An Internet connection is

required to activate the license and check the license status when the Software is used.

Once the subscription term is over, you will be able to either stop using the Software or renew

the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version

on a single computer without an active subscription. A subscription provides access to new

product releases, regular upgrades, and support for new server versions provided during the

subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a

single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in

a single company as well as deploy the Software as part of a licensee's application to web

servers, application servers, batch servers, desktops, and other end-user devices. This

definition includes the ability to install and use the application containing the Software without

any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
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hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.

1.4. If you have the "OEM License", you are also entitled to:

- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into

your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation

section.

No other rights or privileges are granted in this Agreement.

2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions

of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written

permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your

Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the

Software license is non-transferable, and you may not transfer the Software installation

package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights

notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs

(Applications) created using the Software. You cannot distribute the Software integrated into

your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's

exclusive property.

4. TRANSFER

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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You may not transfer the Software to any individual or entity without express written

permission from Devart. In particular, you may not share copies of the Software under

"Desktop License"  with other co-developers without obtaining proper license of these copies

for each individual; you may not install the Software under "Server License" on more than 1

(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the

event of any failure to comply with any provision of this Agreement. Upon such termination

you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or

distribute Trial versions of the Software as an original installation package only. If the Software

you have obtained is marked as a "Trial" version, you may install and use the Software for a

period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the

additional restriction that it is used solely for evaluation of the Software and not in conjunction

with the development or deployment of any application in production. You may not use

Applications developed using Trial versions of the Software for any commercial purposes.

Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all

accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart

makes no warranties, expressed or implied, including, but not limited to, the implied

warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to

download improvements and enhancement from Devart's web site as they become available,

during the active subscription period. The initial subscription period is one year from the date

of purchase of the license. The subscription is automatically activated upon purchase, and

may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users

of the Software with an active subscription may request technical assistance with using the

Software over email from the Software development. Devart shall use its reasonable

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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endeavors to answer queries raised, but does not guarantee that your queries or problems

will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database

versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by

international copyright laws and treaty provisions. You may not remove the copyright notice

from any copy of the Software or any copy of the written materials, accompanying the

Software.

This Agreement contains the total agreement between the two parties and supersedes any

other agreements, written, oral, expressed, or implied.

2.6 Getting Support

This document lists several ways you can find help with using ODBC Driver for Dynamics

365 Business Central describes the Priority Support program.

Support Options
There are a number of resources for finding help on installing and using ODBC Driver for

Dynamics 365 Business Central:

You can find out more about ODBC Driver for Dynamics 365 Business Central installation

or licensing by consulting Installation and License articles of this manual respectively.

You can get community assistance and technical support on the Community Forum.

You can get advanced technical assistance by ODBC Driver for Dynamics 365 Business

Central developers through the ODBC Driver for Dynamics 365 Business Central Priority

Support program.

Subscriptions
The ODBC Driver for Dynamics 365 Business Central Subscription program is an annual

maintenance and support service for ODBC Driver for Dynamics 365 Business Central

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
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users.

Users with a valid ODBC Driver for Dynamics 365 Business Central Subscription get the

following benefits:

Product support through the ODBC Driver for Dynamics 365 Business Central Priority

Support program

Access to new versions of ODBC Driver for Dynamics 365 Business Central when they are

released

Access to all ODBC Driver for Dynamics 365 Business Central updates and bug fixes

Notifications about new product versions

Priority Support
ODBC Driver for Dynamics 365 Business Central Priority Support is an advanced product

support service for getting expedited individual assistance with ODBC Driver for Dynamics

365 Business Central-related questions from the ODBC Driver for Dynamics 365 Business

Central developers themselves. Priority Support is carried out over email and has a two

business day response policy. Priority Support is available for users with an active ODBC

Driver for Dynamics 365 Business Central Subscription.

To get help through the ODBC Driver for Dynamics 365 Business Central Priority Support

program, please send an email to support@devart.com describing the problem you are

having. Make sure to include the following information in your message:

Your ODBC Driver for Dynamics 365 Business Central Registration number.

Full ODBC Driver for Dynamics 365 Business Central edition name and version number.

You can find the version number in DLL version information.

Versions of the Dynamics 365 Business Central server and client you are using.

A detailed problem description.

If possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Dynamics 365 Business Central.

If you have any questions regarding licensing or subscriptions, please see the FAQ or

contact sales@devart.com

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
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3 Using ODBC Driver

1. Installation

2. Product Activation

3. Connecting to Dynamics 365 Business Central

4. Connection String Parameters

5. Enabling ODBC Tracing

6. Supported Data Types

7. Supported ODBC API Functions

3.1 Installation

ODBC Driver for Dynamics 365 Business Central currently supports Windows 32-bit and 64-

bit.

Regular Installation

Silent Installation

3.1.1 Windows

Installation on Windows
1. Download and run installer executive file.

2. Follow the instructions in the wizard.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
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3. In case you already have the specified installation folder on the PC or another Driver

version is installed, you will get a warning. Click Yes to overwrite the old files with the

current installation, but it is recommended to completely uninstall the previous driver

version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the

driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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5. In the License Information dialog box, you should select the license type and activate the

product. If you have no activation key, you can select Trial and use the driver for evaluation

purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from

the registration email or your Customer Portal account and paste it into the Activation Key

edit box.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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7. If you have the activation key file, click the Load Activation Key button and browse to it.

8. Click Next.

9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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3.1.2 Silent Windows

Silent Installation with OEM license on Windows
1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCDynamics 365 Business Central.exe /SILENT /ActivationKey=y1c7nmgdu234laszxcvONGurjfhxm90LHuyhhsae

DevartODBCDynamics 365 Business Central.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRtrilwq98nbvl4RTukfgre

Note: The installation is performed by entering a license key.

DevartODBCDynamics 365 Business Central.exe /SILENT /ActivationFile=d:\lic.key

DevartODBCDynamics 365 Business Central.exe /VERYSILENT /ActivationFile=d:\lic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is

required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation

process is performed without user interference.

3.2 Remote Installation

One of the key advantages of Group Policy is the ability to deploy software remotely using MSI

files. This section explains how to use Group Policy to remotely install the ODBC Driver for

Dynamics 365 Business Central on client computers.

The information is organized into the following sections:

Creating the MST File Using Orca

Remote Deployment and Activation

Upgrading Driver Version and License Key

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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3.2.1 Package Transformation

Creating the MST File Using Orca
To customize the installation of the ODBC Driver for Dynamics 365 Business Central, you

first need to edit the Windows Installer Package (MSI) by creating an MST file. This will allow

for customized installation of an original Windows Installer (MSI) Package.

An MST file, or Windows Installer Setup Transform file, contains program configuration

settings. In our case, the MST file for the ODBC Driver for Dynamics 365 Business Central

will include the correct license information. This MST file is used together with the original MSI

package in the Group Policy software distribution system.

There are many tools available for customizing MSI file settings, so you can choose the one

that best suits your needs. In this example, we'll be using Orca, which is available as part of

the Windows SDK Components for Windows Installer Developers. For more information

about Orca, visit the official Microsoft website

To start the process of MST file generation using the Orca editor, follow the steps below:

1. Launch the Orca application, then open the required MSI file by selecting Open in the File

menu or click the Open icon on the toolbar below.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group

Policy installation process. Use the same steps described in this section when installing the

ODBC Driver for Dynamics 365 Business Central.

2. As a result, the Tables menu on the left side of the main application window will display the

properties of the selected MSI file.

3. Next, navigate Transform -> New Transform.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
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4. To proceed, select Property from the Tables menu, then double-click any empty row on

the right side of the application window.

In the Add Row dialog that opens, make the following settings and press OK to apply the

changes:

Property - enter ACTIVATIONKEY with capital letters only.

Value - enter the valid OEM license key for the ODBC Driver for Dynamics 365

Business Central.

As shown in the following screen, a new property, ACTIVATIONKEY, has been added, with

the license key displayed in the value column next to it.

5. Once the configuration changes have been made, select Transform -> Generate

Transform.
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6. In the Save Transform As dialog that appears, enter a suitable name for the new MST file

and click Save to apply your settings.

7. If successful, the encryption message DevartODBCSalesforce.msi (transformed by

DevartODBCSalesforce.mst) - Orca will be displayed at the top of the Orca application

window.
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In case of a positive outcome, the newly created MST file will be located in the folder you

specified, alongside the MSI file.

3.2.2 Deployment and Activation

Installing and Activating Software Remotely
Group Policy automated-program installation is specifically designed for deploying Windows

Installer packages (MSI files). Therefore, when deploying the ODBC Driver for Dynamics 365

Business Central using Group Policy, be sure to use the corresponding MSI file for the ODBC

Driver for Dynamics 365 Business Central.

Prerequisites: Locating the MSI Installation File

Prior to making configuration settings in the Group Policy, you'll need to create a distribution

folder:

1. Create a shared network folder on the publishing server.

2. Set the appropriate sharing permissions on this folder to allow read access to the driver
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installation package for all domain users.

3. Download the ODBC Driver for Dynamics 365 Business Central MSI file, and place it in the

network folder.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group

Policy installation process. Use the same steps described in this section when installing the

ODBC Driver for Dynamics 365 Business Central.

Further in this section, you'll find more detailed information on how to deploy and activate the

ODBC Driver for Dynamics 365 Business Central on remote client computers using Group

Policy.

Server-Side Actions
1. Open the Group Policy Management desktop application.

2. In the Group Policy Management window, navigate to the desired forest node, then

expand the appropriate option under the Domains node. For this example, we'll select

devart-test.test. Right-click the Domains node, and from the context menu, select Create

a GPO in this domain, and Link it here.
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3. You can now create a New Group Policy Object. In the New GPO dialog enter a name for

the new object and click OK. The new GPO will then appear within the Group Policy

Management container.

For example, let's create a GPO named after the ODBC driver name.

Keep in mind that each ODBC Driver for Dynamics 365 Business Central Windows

installation package corresponds to one Group Policy Object (GPO), which is important for

managing future software upgrades. To install multiple drivers using Group Policy, you need

to create a separate GPO for each driver you want to deploy.
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4. Right-click the new object and select Edit from the context menu.

5. In the left pane of the Group Policy Management Editor, navigate to Computer

Configuration --> Policies --> Software Settings --> Software installation. Your

current deployment package will appear in the right pane. Right-click Software

installation, then select New --> Package.
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6. In the Group Policy Management Editor dialog that opens, select the desired MSI

installation file and click Open.
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7. In the Deploy Software dialog, select Advanced to specify the software deployment

method. The Advanced deployment method allows you to make necessary modifications

to the MSI file, such as creating the MST file in Orca.

8. In the Properties dialog of the installation package that opens, go to the Modifications tab

and select Add. Browse for the corresponding MST file, select it, and click Open to apply

the settings.
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9. If configured correctly, the Group Policy Management Editor window should look as

follows:

Client-Side Actions

For the ODBC Driver for Dynamics 365 Business Central to be successfully installed on

remote client machines, all domain users must restart their computers after logging in for the

first time.

In case of successful deployment, the ODBC driver will be installed on the client's computer.

To verify, open the ODBC Data Source Administrator on the client's machine and add the

deployed ODBC driver.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html


Using ODBC Driver 31

© 2025 Devart Request Support ODBC Forum Provide Feedback

All information on the deployed driver is accessible upon clicking the About tab.
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Similarly, the valid license key will be automatically activated after the successful installation

of the ODBC Driver for Dynamics 365 Business Central.
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See Also
Creating the MST File Using Orca

Activating on Windows - ODBC Driver for Dynamics 365 Business Central

License Information - ODBC Driver for Dynamics 365 Business Central

3.2.3 Software Upgrade

Automatic Software Update Using Group Policy
If the ODBC Driver for Dynamics 365 Business Central was initially deployed through Group

Policy, it can be easily updated to a newer version. Follow the steps below to update both the

ODBC Driver for Dynamics 365 Business Central and the license to newer versions on all

remote computers in the domain.
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1. Download the ODBC Driver for Dynamics 365 Business Central installation MSI file of a

newer version and place it in the shared network folder.

2. Create a new MST file with a new license key using Orca.

If your license is still valid, there's no need to create a new MST file. Use the current MST file

instead.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group

Policy installation process. Use the same steps described in this section when installing the

ODBC Driver for Dynamics 365 Business Central.

3. Follow the same workflow as outlined in Step 4 to Step 7 of the ODBC Driver for Dynamics

365 Business Central Remote Deployment and Activation section.

4. In the Properties dialog that appears after selecting the Advanced deployment method,

go to the Upgrades tab and click Add.
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Make sure to select the following check boxes while adding the package:

Current Group Policy Object

Package can upgrade over the existing package

5. Browse for the corresponding GPO object and click OK to apply the settings.
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6. Now the Upgrades tab of the Properties dialog will list a new package with a newer

version.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html


Using ODBC Driver 37

© 2025 Devart Request Support ODBC Forum Provide Feedback

7. Go to the Modifications tab in the same properties dialog, click Add and browse to the

MST file.

We have already created a new MST file with a new license key in Step 2.
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8. In case of a positive outcome both the old and new versions of the driver package will be

displayed in the Group Policy Management Editor.

Once the GPO configuration on the server is complete, the ODBC Driver for Dynamics 365
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Business Central will automatically update to the latest version each time a client computer

restarts.

Client-Side Actions

To update the ODBC Driver for Dynamics 365 Business Central to a newer version on

remote client machines, all domain users must restart their computers after their first login.

If successful, both the driver and the license key will be automatically updated to the new

version on remote computers. For detailed instructions on how to view the technical details of

the ODBC Driver for Dynamics 365 Business Central after upgrading, refer to Client-Side

Actions.

See Also
Creating the MST File Using Orca

Remote Deployment and Activation - ODBC Driver for Microsoft Access

Activating on Windows - ODBC Driver for Dynamics 365 Business Central

License Information - ODBC Driver for Dynamics 365 Business Central

3.3 Product Activation

See how to activate Devart ODBC Driver for Dynamics 365 Business Central:

Obtaining Activation Key

Activation on Windows

Where to see the license information

3.3.1 Obtaining Activation Key

To obtain a product activation key, follow these instructions:

1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.
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3. You can copy the Activation Key either from the registration email or at the Customer Portal

account.

4. To login to the Customer Portal, use your Username and Password from the registration

email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:

6. Copy the Activation Key with the Copy to Clipboard button.

See also:
Activation on Windows

3.3.2 Activation on Windows

Driver Activation After Installation
To activate your installed driver using ODBC Administrator, perform the following steps:

1. Run ODBC Administrator.
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2. In the System DSN tab click the Add button.

3. In the appeared dialog box, select the installed driver, click Finish.
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4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

6. If you have the activation key file, click the Load Key button and browse to it.

7. Click OK.
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3.3.3 Where to See the License Information?

To see the license information of your installed driver, do the following:

1. In the Control Panel run ODBC Administrator

2. Open the System DSN tab and click the Add button

3. Select the driver and click Finish
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4. In the appeared dialogue, select the License tab
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See also
Product Activation

3.4 Connecting to Dynamics 365 BC

This section describes how to connect to Dynamics 365 Business Central using ODBC

Driver for Dynamics 365 Business Central

1. Driver Configuration

2. Obtaining an Access Key

3. Obtaining a Refresh Token

3.4.1 Driver Configuration

Windows DSN Configuration
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After installing the driver, create a DSN for ODBC Driver for Dynamics 365 Business Central

in the ODBC Data Source Administrator.

1. Open the ODBC Data Source Administrator.

Type ODBC Data Sources in the Windows search box and choose the application that

matches the bitness of the third-party application (32-bit or 64-bit). You can also open 

ODBC Data Sources from Control Panel > Administrative Tools. Note that before

Windows 8, the icon was named Data Sources (ODBC).

Alternatively, you can run C:\Windows\SysWOW64\odbcad32.exe to create a 32-bit DSN or C:

\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet

some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for Dynamics 365 Business Central and click Finish. The

driver setup dialog will open.

5. Enter the connection information in the appropriate fields. Finally, click OK to save the

DSN.

Basic Authentication

If you choose this authentication type, enter the username and password for your Dynamics

365 Business Central account.

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html


ODBC Driver for Dynamics 365 Business Central48

© 2025 Devart Request Support ODBC Forum Provide Feedback

Token-Based Authentication

If you authenticate with OAuth2, click Sign in to Dynamics BC, enter your credentials, and

grant the requested permissions to generate a refresh token.
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For both authentication types, you may test the connectivity by clicking Test Connection.

See Also

Connection String Parameters

Obtaining an Access Key

Obtaining a Refresh Token
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3.4.2 Obtaining Connection Details - Basic

To start the process of obtaining a web service access key, follow the steps below:

1. Access the web client of your Dynamics 365 Business Central instance by logging in.

2. In the Search field, type users and select the Users page.

3. Select the required user and then click User Name.
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4. Copy the existing Web Service Access Key or generate a new one instead.
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5. Now, you can access your Dynamics 365 Business Central account data.

See Also

Configuring ODBC Driver for Dynamics 365 Business Central

3.4.3 Obtaining Connection Details - OAuth 2.0

To start the process of generating a refresh token for the ODBC driver for Dynamics 365

Business Central, follow the steps below:

1. Run the ODBC Administrator utility and make proper settings in the driver's Configuration

dialog.

2. Click Sign in to Dynamics BC.
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3. Specify your credentials or select a different sign-in option to log in and click Next.

4. Now, click Accept to give permission for data access.
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If the process is successful, the refresh token will be automatically generated and inserted in

the corresponding field of the driver configuration window.

5. Therefore, click OK to save your configuration settings.
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6. Finally, you can access your Dynamics 365 Business Central account data.

See Also

Configuring ODBC Driver for Dynamics 365 Business Central

3.5 Connection String Parameters

Dynamics 365 Business Central ODBC Connection
String Parameters
The following table lists the connection string parameters for Dynamics 365 Business

Central.

Parameter Description
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Authentication

The authentication type to use when
connecting to Dynamics 365 Business
Central.
The possible values are:

Basic - The basic user/password

authentication type.

OAuth 2.0 - The OAuth 2.0 authentication

type.

Server
The URL of the Dynamics 365 Business

Central server.

User ID

The Dynamics 365 Business Central

username. Available when the User ID and

Password authentication type is selected.

Access Key

The web service access key generated in the

user account allowing authorization of a

specific application to access Dynamics 365

Business Central data. To save your access

token in the DSN settings, select Save Key.

Company Name

Specify a custom company name by

selecting the appropriate option from the

drop-down menu.

Company Id
Сustom Company Id for the Dynamics 365

Business Central OAuth 2.0.

Environment Name

Specify a custom environment name by

selecting the appropriate option from the

drop-down menu.

Refresh Token

The Dynamics 365 Business Central OAuth

2.0 token. Available when the OAuth 2.0

authentication type is selected.
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Proxy Settings

Proxy Server The proxy hostname or IP address.

Proxy User ID The proxy hostname or IP address.

Proxy Password The proxy password.

Proxy Port The proxy port.

Advances Settings

AllowNullStringsInMetadata Some parameters don't accept null values

when retrieving metadata. If a third-party tool

passes a null value to such a parameter, the

driver returns an error. By default, these

options are enabled for compatibility with

such third-party tools.

EmptyStringsAsNullInMetadata

Cache Metadata

This is a configurable parameter, which
allows caching and storing metadata in a
temporary database. The parameter settings
specify the frequency of resetting cached
metadata ranging from 1 hour...to 1 month.

False - The metadata caching is disabled.

Hour - Cached metadata is reset one time

per hour.

Day - Cached metadata is reset once a day

(i.e. every 24 hours).

Month - Cached metadata is reset once per

month.

True - Metadata caching won't reset until

the driver is unloaded.

Connection Timeout The time (in seconds) to wait for a connection
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to open before terminating an attempt. The

default value is 60.

ODBC Behavior

Sets the behavior corresponding to the
ODBC specification version expected by a
third-party tool. The behavior of the ODBC
driver can be changed by calling the 
SQLSetEnvAttr function to set the
SQL_ATTR_ODBC_VERSION environment
attribute. Some third-party tools expect the
driver to exhibit ODBC 2.x behavior, but
forget to call SQLSetEnvAttr with the needed
version, or pass the incorrect value. In this
case, the behavior can be explicitly set in the 
Connection String.

0 - The default value. ODBC behavior is

determined by a third-party tool.

2 - ODBC 2.x behavior is explicitly set.

3 - ODBC 3.x behavior is explicitly set.

QueryTimeout
The time to wait for a query execution result

before terminating and generating an error.

RegionalNumberSettings
Enables the use of local regional settings

when converting numbers to strings.

RegionalDateTimeSettings
Enables the use of local regional settings

when converting dates and times to strings.

ReturnForeignKeys

Use the parameter to specify whether the

driver must return foreign keys. Retrieving

metadata about foreign key constraints is a

time-consuming operation; many third-party

tools request foreign key metadata even

whey they do not actually need this

information. Note that enabling the option

may degrade performance of data access

operations. The default value is False.
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String Types

Sets the string value types returned by the
driver as Default, ANSI, or Unicode.

Default - The driver defines the string

types.

Ansi - All string types are returned as

SQL_CHAR, SQL_VARCHAR, and

SQL_LONGVARCHAR.

Unicode - All string types are returned as

SQL_WCHAR, SQL_WVARCHAR, and

SQL_WLONGVARCHAR.

Set the parameter to Ansi or Unicode, if your

third-party tool supports only Ansi or Unicode

strings.

UTC Dates

Specifies whether all the datetime values

retrieved from the data source are returned

as UTC values or converted to local time and

whether the date values specified on the

application side (e.g., in SQL statements)

are considered UTC or local. The default

value is false.

Sample Dynamics 365 Business Central ODBC Connection String

DRIVER={Devart ODBC Driver for Dynamics 365 Business

Central};Refresh Token=mytoken

3.6 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows
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When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled

or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any

other user login than your own, select Machine-Wide tracing for all user identities. For

example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps

below.

1. Type ODBC Data Sources in the Windows 10 search box (in earlier versions of Windows,

open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

3. If necessary, change the default Log File Path. Make sure that the path is writable by the

application, then click Apply.

4. Click Start Tracing Now.

5. Restart all application processes.

6. Click Test Connection in the DSN settings to make sure the driver is able to connect.

7. Reproduce the issue.

8. Click Stop Tracing Now on the Tracing tab.

9. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS
To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.

1. Open the ODBC Administrator.

2. Select the Tracing tab.

3. If necessary, change the default Log file path.

4. Select All the time in the When to trace option.

Creating an ODBC Trace Log on Linux
To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the

[ODBC] section of the /etc/odbcinst.ini file, for example:
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[ODBC]
Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

3.7 Supported Data Types

Data Type Mapping
The Devart ODBC Driver for Dynamics 365 Business Central supports all Dynamics 365

Business Central data types.

The following table describes how the Dynamics 365 Business Central data types are

mapped to the ODBC data types.

Dynamics Data Types ODBC Data Types

BINARY SQL_VARBINARY

STRING

SQL_VARCHAR

SQL_LONGVARCHAR

SQL_WVARCHAR

SQL_WLONGVARCHAR

BOOLEAN SQL_BIT

INT SQL_INTEGER

LONG SQL_BIGINT

DOUBLE
SQL_FLOAT

SQL_DOUBLE

DECIMAL SQL_DECIMAL

TIME SQL_TYPE_TIME

DATE SQL_TYPE_DATE

DATETIME SQL_TYPE_TIMESTAMP

GUID SQL_GUID
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3.8 Supported ODBC API Functions

Supported ODBC Functions
The SQLGetInfo function returns information about the driver and data source. To find out

whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Dynamics 365 Business Central supports all deprecated functions for

backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose

SQLAllocHandle ISO 92

Obtains an

environment,

connection,

statement, or

descriptor handle.

SQLConnect ISO 92

Connects to a

specific driver by

data source name,

user ID, and

password.

SQLDriverConnect ODBC

Connects to a

specific driver by

connection string or

requests that the

Driver Manager and

driver display

connection dialog
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boxes for the user.

SQLAllocEnv Deprecated

Obtains an

environment handle

allocated from driver.

SQLAllocConnect Deprecated
Obtains a

connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose

SQLDataSources ISO 92

Returns the list of

available data

sources, handled by

the Driver Manager

SQLDrivers ODBC

Returns the list of

installed drivers and

their attributes,

handles by Driver

Manager

SQLGetInfo ISO 92

Returns information

about a specific

driver and data

source.

SQLGetFunctions ISO 92

Returns the functions

supported by the

driver.

SQLGetTypeInfo ISO 92

Returns information

about supported

data types.
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ODBC API Calls for Setting and Retrieving Driver
Attributes

Function Name Support Standard Purpose

SQLSetConnectAttr ISO 92
Sets a connection

attribute.

SQLGetConnectAttr ISO 92

Returns the value of

a connection

attribute.

SQLSetConnectOpti

on
Deprecated

Sets a connection

option

SQLGetConnectOpti

on
Deprecated

Returns the value of

a connection option

SQLSetEnvAttr ISO 92
Sets an environment

attribute.

SQLGetEnvAttr ISO 92

Returns the value of

an environment

attribute.

SQLSetStmtAttr ISO 92
Sets a statement

attribute.

SQLGetStmtAttr ISO 92
Returns the value of

a statement attribute.

SQLSetStmtOption Deprecated
Sets a statement

option

SQLGetStmtOption Deprecated
Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name Support Standard Purpose
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SQLAllocStmt Deprecated
Allocates a

statement handle

SQLPrepare ISO 92

Prepares an SQL

statement for later

execution.

SQLBindParameter ODBC

Assigns storage for

a parameter in an

SQL statement.

SQLGetCursorNam

e
ISO 92

Returns the cursor

name associated

with a statement

handle.

SQLSetCursorNam

e
ISO 92

Specifies a cursor

name.

SQLSetScrollOption

s
ODBC

Sets options that

control cursor

behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

SQLExecute ISO 92
Executes a prepared

statement.

SQLExecDirect ISO 92
Executes a

statement

SQLNativeSql ODBC

Returns the text of an

SQL statement as

translated by the

driver.

SQLDescribeParam ODBC Returns the
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description for a

specific parameter

in a statement.

SQLNumParams ISO 92

Returns the number

of parameters in a

statement.

SQLParamData ISO 92

Used in conjunction

with SQLPutData to

supply parameter

data at execution

time. (Useful for long

data values.)

SQLPutData ISO 92

Sends part or all of a

data value for a

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose

SQLRowCount ISO 92

Returns the number

of rows affected by

an insert, update, or

delete request.

SQLNumResultCols ISO 92

Returns the number

of columns in the

result set.

SQLDescribeCol ISO 92
Describes a column

in the result set.
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SQLColAttribute ISO 92

Describes attributes

of a column in the

result set.

SQLColAttributes Deprecated

Describes attributes

of a column in the

result set.

SQLFetch ISO 92
Returns multiple

result rows.

SQLFetchScroll ISO 92
Returns scrollable

result rows.

SQLExtendedFetch Deprecated
Returns scrollable

result rows.

SQLSetPos ODBC

Positions a cursor

within a fetched

block of data and

enables an

application to refresh

data in the rowset or

to update or delete

data in the result set.

SQLBulkOperations ODBC

Performs bulk

insertions and bulk

bookmark

operations, including

update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic
Information
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Function Name Support Standard Purpose

SQLError Deprecated

Returns additional

error or status

information

SQLGetDiagField ISO 92

Returns additional

diagnostic

information (a single

field of the

diagnostic data

structure).

SQLGetDiagRec ISO 92

Returns additional

diagnostic

information (multiple

fields of the

diagnostic data

structure).

ODBC API Calls for Obtaining Information About
Database Objects (Catalog Functions)

Function Name Support Standard Purpose

SQLColumnPrivileg

es
ODBC

Returns a list of

columns and

associated

privileges for one or

more tables.

SQLColumns X/Open

Returns the list of

column names in

specified tables.

SQLForeignKeys ODBC Returns a list of
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column names that

make up foreign

keys, if they exist for

a specified table.

SQLPrimaryKeys ODBC

Returns the list of

column names that

make up the primary

key for a table.

SQLProcedureColu

mns
ODBC

Returns the list of

input and output

parameters, as well

as the columns that

constitute the result

set for the specified

procedures.

SQLProcedures ODBC

Returns the list of

procedure names

stored in a specific

data source.

SQLSpecialColumn

s
X/Open

Returns information

about the optimal set

of columns that

uniquely identifies a

row in a specified

table, or the columns

that are

automatically

updated when any

value in the row is

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html


ODBC Driver for Dynamics 365 Business Central70

© 2025 Devart Request Support ODBC Forum Provide Feedback

updated by a

transaction.

SQLStatistics ISO 92

Returns statistics

about a single table

and the list of

indexes associated

with the table.

SQLTablePrivileges ODBC

Returns a list of

tables and the

privileges

associated with

each table.

SQLTables X/Open

Returns the list of

table names stored

in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

SQLTransact Deprecated
Commits or rolls

back a transaction

SQLEndTran ISO 92
Commits or rolls

back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose

SQLFreeStmt ISO 92

Ends statement

processing, discards

pending results, and,
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optionally, frees all

resources

associated with the

statement handle.

SQLCloseCursor ISO 92

Closes a cursor that

has been opened on

a statement handle.

SQLCancel ISO 92
Cancels an SQL

statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose

SQLDisconnect ISO 92
Closes the

connection.

SQLFreeHandle ISO 92

Releases an

environment,

connection,

statement, or

descriptor handle.

SQLFreeConnect Deprecated
Releases connection

handle.

SQLFreeEnv Deprecated
Releases an

environment handle.

4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Dynamics 365 Business Central with

ODBC-compliant tools.
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DBeaver

Oracle Database Link

Microsoft Access

SQL Server Management Studio

Microsoft Excel

Microsoft Visual Studio

OpenOffice and LibreOffice

PHP

Power BI

Python

QlikView

SSIS

Tableau

4.1 Using in DBeaver

DBeaver Overview
DBeaver is a free, open source multiplatform database management tool and SQL client for

developers and database administrators. DBeaver can be used to access any database or

cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,

Salesforce, or Mailchimp. DBeaver provides you with the most important features you'd need

when working with a database in a GUI tool, such as:

SQL queries execution

Metadata browsing and editing

SQL scripts management

Data export/import

Data backup

DDL generation
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ER diagrams rendering

Test data generation

BLOB/CLOB support

Database objects browsing

Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports

NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,

SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though

that you can access a MongoDB database from DBeaver Community Edition using the

respective Devart ODBC driver. For the purposes of this guide, we'll use the Community

Edition of DBeaver to retrieve data from Dynamics 365 Business Central via the Open

Database Connectivity driver.

Creating an ODBC Data Source to Use Dynamics 365
Business Central Data in DBeaver
1. Click the Start menu and select Control Panel.

2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system

or select User DSN to configure DSN only for your account.

4. Click the Add button and double-click Devart ODBC Driver for Dynamics 365 Business

Central in the list.

5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for Dynamics 365 Business Central with DBeaver,

SQL_WVARCHAR data types may be displayed incorrectly in DBeaver. To prevent this, you

need to set the string data types to Ansi either in the Advanced Settings tab of the driver

configuration dialog or directly in the connection string (String Types=Ansi) — all string types

will be returned as SQL_CHAR, SQL_VARCHAR and SQL_LONGVARCHAR.
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Connecting to Dynamics 365 Business Central Data
from DBeaver via ODBC Driver for Dynamics 365
Business Central
Follow the steps below to establish a connection to Dynamics 365 Business Central in

DBeaver.

1. In the Database menu, select New Database Connection.
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2. In the Connect to database wizard, select ODBC and click Next.

3. Enter the previously configured DSN in the Database/Schema field.
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4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing Dynamics 365 Business Central Database Objects and
Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all

the tables in Dynamics 365 Business Central database. To view and edit the data in a table,

you need to right-click on the target table name and select View data.The content of the table

will be displayed in the main workspace.
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If you want to write a custom SQL query that will include only the necessary columns from the

table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.

4.2 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC
This article explains how to configure Oracle Database Gateway for ODBC. If your data is

stored in a non-Oracle database system or cloud application, and you need to access it from

an Oracle Database server, you can create a database link to an Oracle Database Gateway

for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,

remote Oracle servers. Any ODBC-compatible data source can be accessed using the

gateway and the appropriate ODBC driver. The driver must be installed on the same machine

as the gateway. The non-Oracle system can run on the same machine as the Oracle server

or on a different machine. The gateway can be installed on the machine running the non-

Oracle system, the machine running the Oracle database or on a third machine as a

standalone.

Configure the Initialization File
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After installing the gateway and the ODBC driver for Dynamics 365 Business Central, create

an initialization file for your Oracle Database Gateway for ODBC. The sample file 

initdg4odbc.ora is stored in the ORACLE_HOME\hs\admin directory. To create an initialization file

for the gateway, copy the sample initialization file and rename it. The name must be prefixed

with init — for example, initDynamics 365 Business Central.ora. You need a separate

initialization file for each ODBC data source. After creating the file, set the 

HS_FDS_CONNECT_INFO parameter to the system DSN that you created earlier, for example:

HS_FDS_CONNECT_INFO=Dynamics 365 Business Central

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with

the Oracle database. Information about the gateway must be added to the listener.ora

configuration file which is located in the ORACLE_HOME\NETWORK\ADMIN\ directory. The following

example is the address on which the Oracle Net Listener listens (HOST is the address of the

machine on which the gateway is installed):

LISTENER =
    (DESCRIPTION_LIST =
        (DESCRIPTION =
          (ADDRESS = (PROTOCOL = TCP)(HOST = localhost)(PORT = 1521))
        )
    )

Add an entry to the listener.ora file to start the gateway in response to connection requests.

The SID of the gateway (SID_NAME) must be the same in listener.ora and tnsnames.ora.

ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new

settings, stop and restart the Oracle Net Listener service.

SID_LIST_LISTENER=
   (SID_LIST=
      (SID_DESC=
         (SID_NAME=Dynamics 365 Business Central)
         (ORACLE_HOME=D:\ORACLE_HOME)
         (PROGRAM=dg4odbc)
      )
   )

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in

ORACLE_HOME\NETWORK\ADMIN directory. The SID must match the value specified in the

listener.ora file.

Dynamics 365 Business Central =
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  (DESCRIPTION =
    (ADDRESS = (PROTOCOL = tcp)(HOST = localhost)(PORT = 1521))
    (CONNECT_DATA =
      (SID = Dynamics 365 Business Central)
    )
    (HS = OK)
  )

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the 

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username"  IDENTIFIED BY "password"  USING 'tns_name_entry';

dblink is the complete database link name. tns_name_entry is the Oracle Net connect

descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a

query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also

Configuring Oracle Database Gateway for ODBC

4.3 Using in DBxtra

Troubleshooting Dynamics 365 Business Central ODBC
Connection in DBxtra
This page explains how to troubleshoot your ODBC connection to Dynamics 365 Business

Central in DBxtra.

Due to incompatibilities between DBxtra and Dynamics 365 Business Central, leaving the SQL

dialect property to its default might present various issues. To resolve compatibility issues,

set the property to MS Access 2000/XP/2003 or ANSI SQL/2003 for DBxtra version 11.0.1 or

newer, and to ANSI SQL/2003 for versions prior to 11.0.1.
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4.4 Using in Microsoft Access

Connecting Microsoft Access to Dynamics 365 Business
Central Using an ODBC Driver
This article explains how to connect Microsoft Access to Dynamics 365 Business Central

through the standard ODBC interface. Microsoft Access is a dababase management system

that combines the relational database engine with a graphical user interface. Access can be

used as a substitution for spreadsheet applications like Excel to organize, store, and retrieve

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html


Using in Third-Party Tools 81

© 2025 Devart Request Support ODBC Forum Provide Feedback

large amounts of related data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Dynamics 365 Business Central data either by

importing it or creating a table that links to the data. Devart ODBC drivers support all modern

versions of Access. It is assumed that you have already installed and configured a DSN for

ODBC driver for Dynamics 365 Business Central. For the purpose of this article, we tested

an ODBC connection to Dynamics 365 Business Central through our ODBC drivers in

Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft Access

2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe how to

use Microsoft Access 2019 to import or link to your data in Dynamics 365 Business Central.

Importing Dynamics 365 Business Central Data Into Microsoft Access
Through an ODBC Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Dynamics 365 Business Central and click OK.

7. In the Import Objects dialog box, select the tables that you want to import, and click OK.

8. If the database objects have been successfully imported, you should the see the

corresponding message in the dialog box. If you want to save the import steps to quickly

repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.

9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Dynamics 365 Business Central Data in Microsoft Access
Through an ODBC Connection
1. Open your Microsoft Access database.
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2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source

by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Dynamics 365 Business Central and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click

OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields

that uniquely identify each record in the table. To avoid inconsistencies, it is recommended

to select the primary key in the Dynamics 365 Business Central table as the unique record

identifier. You are linking multiple tables, you will be prompted to select unique record

identifiers for each of the selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

4.5 Using in Microsoft Excel

Connecting to Dynamics 365 Business Central from
Microsoft Excel using ODBC Driver for Dynamics 365
Business Central
You can use Microsoft Excel to access data from a Dynamics 365 Business Central

database using ODBC connector. With ODBC Driver, you can import the data directly into an

Excel Spreadsheet and present it as a table. Make sure that you use matching Excel and

ODBC Driver, e.g. if you have installed a 64-bit ODBC Driver, you will need to use the 64-bit

version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various

data sources using our ODBC drivers.
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Connecting Excel to Dynamics 365 Business Central with Get & Transform (Power Query)

Connecting Excel to Dynamics 365 Business Central with Data Connection Wizard

(Legacy Wizard)

Connecting Excel to Dynamics 365 Business Central with the Query Wizard

Connecting Excel to Dynamics 365 Business Central with Microsoft Query

Connecting Excel to Dynamics 365 Business Central with PowerPivot

Connecting Excel to Dynamics 365 Business Central
with Get & Transform (Power Query)
You can use Get & Transform (Power Query) to connect to Dynamics 365 Business Central

from Excel with ODBC. This method assumes that you've installed an ODBC driver for

Dynamics 365 Business Central.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other

Sources > From ODBC.
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2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured

your ODBC driver yet, you can expand the Advanced Options dialog box and enter the

connection string for your data source (without credentials, which are defined in the

credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.
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If your database is not password-protected or you've already specified your credentials in the

ODBC data source settings, select Default or Custom and press Connect

4. In the window that appears, select the table you want to retrieve data from, and click Load.
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The data from the table will be a displayed in an Excel spreadsheet where you can further

work with it.

Connecting Excel to Dynamics 365 Business Central
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with Data Connection Wizard (Legacy Wizard)
You can use this option to connect to OLE DB or ODBC external data source that has

already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.

2. In the opened dialog, select ODBC DSN and click Next to continue.

3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Dynamics 365 Business Central
with the Query Wizard
You can use this option to create a simple query for retrieving data from Dynamics 365

Business Central to Excel via ODBC driver.

1. Open Excel, in the main menu, click the Data tab.

2. Click the From Other Sources dropdown menu, and then click From Microsoft Query.

3. In the appeared dialog, you can choose the data source you want to connect to.

4. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.

5. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.

6. If you plan to further use the query, you can save it by clicking the Save button on the right.

7. Select Return Data To Microsoft Excel and click Finish.

8. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.
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Connecting Excel to Dynamics 365 Business Central
with Microsoft Query
You can use this option to create a more complex query for retrieving Dynamics 365

Business Central data to Excel via ODBC driver.

1. Start Excel, click the Data tab.

2. In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

3. In the next dialog, choose the data source you want to connect to (e.g., using data source

name - Devart ODBC Dynamics 365 Business Central). Uncheck Use the Query Wizard

to Create/Edit Queries and click OK.

4. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

5. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Dynamics 365 Business Central
with PowerPivot
You can use PowerPivot - an Excel add-in to perform data analysis and create complex data

models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.

3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,

using data source name - Devart ODBC Dynamics 365 Business Central), and then click 

Next.

6. Now you should choose how to import the data (either select a table from the list or write a

query to specify the data to be imported).

7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.
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4.6 Using in Microsoft Visual Studio

Importing Dynamics 365 Business Central Data into
Visual Studio Through an ODBC Connection
A Visual Studio is a powerful tool containing features that allow editing, debugging, and

compilating the code and creating applications that can be connected to any databases

product and services on a local machine and network, and any type of cloud (private, public,

or hybrid). To connect Visual Studio to a data source such as Dynamics 365 Business

Central, you can use an appropriate ODBC driver.

This guide describes how to connect to Dynamics 365 Business Central and retrieve data

importing them to Visual Studio with an ODBC driver. It is assumed that you have already

installed and configured a DSN for ODBC driver for Dynamics 365 Business Central.

1. Run Visual Studio Desktop and click Tool and select Connect to Database.

2. In the Add connection dialog box, select the Microsoft ODBC Data Source as a data

source.

3. In the Data source specification point expand the Data Source Name (DSN) drop-down

list and select the previously configured DSN for Dynamics 365 Business Central.

Alternatively, you can connect to the database by entering the DSN in a Use connection

string field. To check whether your connection is successful, click Test connection.

Click OK.

4. If your data source is password-protected, Visual Studio will prompt you for user

credentials. Type your Username and Password in the respective fields and click OK.

5. In the Server Explorer you can see the database structure. Choose Tables, right-click the

table you want to view the data of and select Retrieve Data. You can also preview the

contents of the database objects by clicking on them.

4.7 Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Dynamics 365

Business Central from SQL Server Management Studio using ODBC Driver for Dynamics
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365 Business Central.

Creating a Linked Server

Troubleshooting in SSMS

4.7.1 Creating a Linked Server

Requirements
In order to avoid incorrect integration with MS SSMS, the working environment must meet the

following conditions:

The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

The driver, studio, and SQL Server must be of the same bitness. For example, if you are

using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure

the 64-bit version of the driver using ODBC Administrator launched from %windir%

\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC

Administrator - launch it from %windir%\SysWOW64\odbcad32.exe.

ODBC Driver for Dynamics 365 Business Central and SQL Server must be installed on the

same computer.

.NET Framework 4.5 must be installed on the computer.

Connecting to Dynamics 365 Business Central from
SQL Server Management Studio using ODBC Driver for
Dynamics 365 Business Central
You can use the Microsoft SQL Server Management Studio to connect your Dynamics 365

Business Central data to an SQL Server instance. Linked Server is a tool of MS SQL Server

that allows to execute distributed queries to refer tables stored on non-SQL Server datbase in

a single query. With linked servers, you can execute commands against different data

sources such as Dynamics 365 Business Central and merge them with your SQL Server

database. You can create a linked server with one of these methods: by using the options in

the Object Explorer or by executing stored procedures.
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Below are major advantages of using SQL Server Linked Servers to connect to Dynamics

365 Business Central:

1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Dynamics 365 Business Central
You can follow the steps to create a linked server for Dynamics 365 Business Central in SQL

Server Management Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.

2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.

3. Configure your linked server in the dialog box:

Give a name for your server in the Linked server field.

Under Server type, select Other data source .

Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down

list.

In the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for

Dynamics 365 Business Central . Alternatively, you can input the ODBC Driver

connection string in the Provider field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can

now issue distributed queries and access Dynamics 365 Business Central databases

through SQL Server.

Retrieving Data From Dynamics 365 Business Central
Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is

enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on

it
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In the appeared Provider Options window, enable the Allow inprocess checkbox:

Create a new Linked Server
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Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

Now you need to input the Linked Server name, e.g. DYNAMICSBC. In the Product Name and

Data Source fields you need to indicate the System DSN that you've previously created -

more info on System DSN setup can be found here.
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The Dynamics 365 Business Central tables are already available to be fetched. To query the

linked server, click New Query in the toolbar:

Enter your SQL query in the editor window and click Execute to run the query:
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As a result, you can see the contents of the selected table retrieved directly from the

Dynamics 365 Business Central account you are connected to.

See also
Troubleshooting SSMS

4.7.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with

DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security

settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:
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4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions

available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are

connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-

11D1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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After this you should be able to edit MSDAINITIALIZE security settings .

See also
Error message when you try to create an instance of an OLE DB provider in SQL Server:

"Cannot create an instance of OLE DB provider"

4.8 Using in OpenOffice and LibreOffice

Connecting to Dynamics 365 Business Central from
OpenOffice and LibreOffice using ODBC Driver for
Dynamics 365 Business Central
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The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data

sources using the respective driver. You can access Dynamics 365 Business Central data

from Open Office Base or LibreOffice Base — desktop database management systems.

Note that the Windows version of OpenOffice is 32-bit, and you may get the error “The

specified DSN contains an architecture mismatch between the Driver and Application” when

trying to access a data source through a 64-bit ODBC Driver. To get rid of the error message,

set up the 32-bit version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for

Dynamics 365 Business Central, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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3. Specify the name of the data source you want to connect to. You can either type the name

of your data source into the field, e.g. ODBC Driver for Dynamics 365 Business Central,

or you can click Browse, double-click the data source you need, and then click Next.
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4. If your database requires a user name, type it into the User name field. If you are

connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Dynamics 365 Business Central and leave these fields empty in Database

Wizard.

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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You will be prompted to give a name to your new database and select the directory where you

want to store it.
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6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-

click the table name.
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7. To create an SQL query, click Queries in the Database pane, then click Create Query in

SQL View…

https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html


Using in Third-Party Tools 109

© 2025 Devart Request Support ODBC Forum Provide Feedback

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

4.9 Using in PHP

Connecting to Dynamics 365 Business Central from
PHP using ODBC Driver for Dynamics 365 Business
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Central
PHP is one of the most popular programming languages for website development. ODBC

drivers are connectors that make PHP development database agnostic — your software

written in PHP will function with any vendor's database management system. You can use

functions like odbc_exec() to prepare and execute SQL statements against any databases

like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-

based database. You can establish a connection to them using ODBC interface. With our

ODBC drivers, you can access various data sources and retrieve tables and fields from a

database.

Below is a sample PHP script for accessing Dynamics 365 Business Central via ODBC. The

script connects to Dynamics 365 Business Central database and fetches all records from a

table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the

function takes three mandatory parameters: the data source name, username and password.

If your database is not password-protected or doesn't require a username, leave these

parameters empty. In the following example, a connection is established using the 

odbc_connect() function in PHP.

 <?php
    $user = "myusername";
    $password = "mypassword";
    $ODBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for Dynamics 365 Business Central};Server=myserver;String Types=Unicode", $user, $password);

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT

statement against the dept table in the autotest database.

 $SQLQuery = "SELECT * FROM autotest.dept";
    $RecordSet = odbc_exec($ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While

odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML

table. After all rows from the result set have been printed, the odbc_close() function closes
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the connection.

   $result = odbc_result_all($RecordSet, "border=1");
   odbc_close($ODBCConnection);
?>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.

4.10 Using in Power BI

Importing Dynamics 365 Business Central Data into
Power BI Through an ODBC Connection
Power BI is a popular business intelligence solution that is comprised of services, apps, and

connectors that allow you to pull raw data from various sources and create meaningful

reports. To connect Power BI to a data source such as Dynamics 365 Business Central, you

can use a corresponding ODBC driver.

This tutorial explores how to connect to Dynamics 365 Business Central and import data into

Power BI Desktop using an ODBC driver. It is assumed that you have already installed and

configured a DSN for ODBC driver for Dynamics 365 Business Central.

1. Run Power BI Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect

to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and

select the previously configured DSN for Dynamics 365 Business Central

4. If you would like to enter a SQL statement to narrow down the returned results, click the 

Advanced options arrow, which expands the dialog box, and type or paste your SQL

statement.

5. Click OK. If your data source is password-protected, Power BI will prompt you for user

credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents

of the database objects by clicking on them.

7. To load the Dynamics 365 Business Central data into Power BI for analysis, select the
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needed table and click Load.

4.11 Using in Python

Installing the ODBC Driver for Dynamics 365 Business
Central
One of the most convenient methods to connect to an external database or access cloud

data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to

work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download

the appropriate installer and run it. You will also need to install the pyodbc module — the

easiest way to do that is by using the pip install pyodbc command in the Python interactive

mode. Next, you need to download the ODBC Driver for Dynamics 365 Business Central. To

use the ODBC driver as a translation layer between the application and the database, you

need to configure it by following the installation instructions.

Connecting to Dynamics 365 Business Central from
Python using ODBC Driver for Dynamics 365 Business
Central
Here’s an example to show you how to connect to Dynamics 365 Business Central via Devart

ODBC Driver in Python. First we import the pyodbc module, then create a connection to the

database, insert a new row and read the contents of the EMP table while printing each row to

the Python interactive console. To execute the script, you can type the code directly in the

interactive console or add the code to a file with the .py extension and run the file from the

command prompt.

Step 1: Connect

import pyodbc
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Dynamics 365 Business Central};Server=myserver;User ID=myuserid;Password=mypassword;String Types=Unicode')

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the

database. The script inserts a new record to the EMP table.
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cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott', 'Manager', 545)")

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The

cursor.fetchone() function iterates over the result set returned by cursor.execute() while the

print() function prints out all records from the table to the console.

cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:
 print (row)
 row = cursor.fetchone()
cursor.close()
cnxn.close()

4.12 Using in QlikView

Connecting to Dynamics 365 Business Central from
QlikView using ODBC Driver for Dynamics 365 Business
Central
This tutorial describes how to connect and configure QlikView to retrieve data from Dynamics

365 Business Central for further analysis. QlikView is a data visualization tool that connects

and pulls data from different popular databases like MySQL, MongoDB, Oracle, SQL Server,

Postgres, etc. to present it in a single view. The business intelligence platform identifies

relationships in your data and discovers patterns and opportunities to support your decision

making.

QlikView supports the ODBC connectivity interface for communication with external data

sources. An ODBC data source must be configured for the database you want to access.

You can create an ODBC connection using a DSN during the ODBC driver installation or

later.

To connect to an ODBC data source from QlikView using our driver for Dynamics 365

Business Central, perform the steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started

wizard and open File > Edit Script (CTRL+E).
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2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select

the Data Source you created earlier, type in the User ID and Password if your database is

password-protected. You can test the connection by choosing Test Connection. The

Connection Test succeeded message should appear. Click OK to connect to your data

source.
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3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.
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4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and
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clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.

5. Once the data has been fetched, you can choose a table layout to present the data in a

table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to

the tablebox and click OK.
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4.13 Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to

perform various data migration tasks. When using Devart ODBC Driver for Dynamics 365

Business Central as a translation layer between the data source and SSIS, the driver and

SSIS communicate via Microsoft ODBC version 3.x.
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Note that when you extract data from an ODBC data source using the SQLExecDirect function,

an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues

to fetch data from a data source via ODBC version 3.x. To prevent any issues when using

SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the 

Advanced Settings tab and select Ver 2.x from the ODBC Behavior dropdown.

4.14 Using in Tableau

Importing Dynamics 365 Business Central Data Into
Tableau Through an ODBC Connection
This article explains to establish and ODBC connection to Dynamics 365 Business Central

from Tableau Desktop. Tableau is a data visualization tool that allows you to pull in raw data,

perform analysis on it, and create meaningful reports to get actionable insights. With Tableau
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Desktop and our suite of ODBC drivers, you can connect to various relational and non-

relational databases, both cloud and on-premise.

1. Run Tableau Desktop.

2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured

for Dynamics 365 Business Central. Alternatively, if you have not created a DSN, you can

choose the Driver option and select Devart ODBC Driver for Dynamics 365 Business

Central from the drop-down.

5. Click Connect.

6. After a successful connection, click Sign in.

7. Select the needed database and schema in Dynamics 365 Business Central.

8. You should see the list of all tables you have access to in the connected data source.

9. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the

data, or click New Custom SQL to write a query that will select only specific data from the

table.

10.Hit Update Now to retrieve and display the data.
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